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Erste Schritte, ganz schnell – ultra quick in 
TimingDiagrammer Pro, WaveFormer Pro, DataSheet Pro & Co 
  
File > New Timing Diagram oder 

File > Open Timing Diagram 
Wie in jedem Programm für Windows legen 
Sie neue Dateien, bzw. öffnen Sie neue 
Dateien an. Das Dateiformat ist hier .btim. 

 
 

  

 

In der linken oberen Ecke des neuen Fensters für das neuen 
Timing Diagramm finden Sie die Schaltflächen zum Anlegen 
neuer: 

• Signale 

• Clock-Signale, 

• Bus Signale und 

• Spacer. 

Spacer erzeugen zusätzliche vertikale Abstände zwischen den 
Signalen. Spacer dienen der besseren Übersichtlichkeit, wenn 
Sie z. B. im  Timing Diagramm Textblöcke zur Beschreibung 
von Signal Situationen einsetzen. 

 

 

  

 

Mit der Schaltfläche  

Add Clock  

fügen Sie in das Timing Diagramm ein Clock-Signal ein. 
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Weiter unten finden Sie OK und 
eine Markierung für den Zustand 
der Clock beim Start. 

Jedes Signal hat Eigenschaften: 

Parameters oder Properties. 

Beim Anlegen einer neuen Clock erscheint das  

Edit Clock Parameters  

Fenster. 

Default Frequenz ist 10 MHz – könne Sie natürlich 
ändern. 

Ein Clock Signal kann von einer anderen Clock 
abgeleitet werden – siehe 

 Reference Clk und Period Formular. 

Wenn Sie säter nochmals in die Edit Clock Parameters 
einsteigen woollen, machen Sie das mit einem 
Doppelklick linke Maustaste (DLM) im Signalbereich 
des  Timing Diagramms. 

 

  

 

Mit der Schaltfläche  

Add Signal  

fügen Sie in das Timing Diagramm einfache ein Signal ein. 
 

  
Im Timing Diagramm 
erscheint zunächst das neue 
Signal nur mit dem vom 
Programm vorgegebenen 
Namen - können Sie 
natürlich ändern – und ohne 
Signalzustände. Die kennen  
nur Sie, müssen also von 
Ihnen in das Timing 
Diagramm eingebracht 
werden – mit der Maus oder 
mit anderen Methoden. 
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Diese  

Signalzustands Schaltflächen  

repräsentieren alle möglichen 
Signalzustände. 

Wenn Sie die Signalzustände mit der linken Maustaste in 
das Timing Diagramm einbringen, so sind die Schaltflächen 
für die Signalzustände ganz wichtig – Sie werden sich 
schnell daran gewöhnen. 

Die rote Schaltfläche definiert den nächsten 
Signalzustands Eintrag in das Timing Diagramm. 

Danach wird der Signalzustand entsprechend der 
Schaltfläche mit dem roten T (manchmal nur als Dreieck zu 
erkennen) eingetragen. 

Die Umschaltung erfolgt automatisch, wenn Sie die linke 
Maustaste loslassen. 

 
 
  

 
Weiter unten finden Sie OK zum Schließen 
der Signal Properties. 

Eine der Alternativen zur Signalzustands 
Definition mit den Schaltflächen ist das vom 
Hersteller sog. Simulated Signal. 
TimingDiagrammer Pro kann das nicht, aber 
WaveFormer Pro, DataSheet Pro & Co 
können das. 

Bringen Sie ein zweites Signal in Ihr Timing 
Diagramm – Sie wissen schon: Mit  

Add Signal. 

Ein DLM auf dem wieder vom Programm 
vorgegebenen Signal Namen öffnet Ihnen 
das Signal Properties Fenster. Hier können 
Sie u. a. den Signal Namen ändern. 

Unter dem Dropdown Feld Boolean Eqn 
tragen Sie bitte in das Feld SIG0 and CLK0 
ein und klicken Sie dann auf Simulate. 
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Eine Alternative zur Boolschen Gleichung wäre hier die Eingabe eines HDL 
Codes - z. B. VHDL -  gewesen.   

Dafür müssen Sie auf den Reiter VHDL in den Signal Properties klicken 
und schon kommt ein beliebig großes Eingabe Fernster. 

 
 

Das aus SIG0 & CLK0 abgeleitete Signal hat eine andere Farbe – by default. 

Mit einem Klick rechte Maustaste auf einem Signal Namen können auch Sie die 
Farbe und Erscheinungsweise des Signals einstellen. 

 

 

Verändern Sie mal mit der linken Maustaste die Position einer Signalflanke von 
SIG0 – die Flanken der Clock können Sie nicht mit der Maus verschieben: Sie 
werden sehen, dass die entsprechende Flanke von SIG1 mitwandert. Die 
Simulation läuft also im Hintergrund weiter. 

 

 

  

 

Viele Signale in einem Timing Diagramm haben weitere 
Abhängigkeiten zueinander, z. B. Delays. 

So geht’s: Markieren Sie mit der linken Maustaste eine Flanke 
auf die sich die Verzögerung beziehen soll und danach 
markieren Sie mit  der rechten Maustaste die verzögerte 
Flanke des betreffenden Signals.  
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So sieht’s aus: Ein Delay 
von einer CLK0-Flanke zu 
einer SIG0-Flanke. 

Die hier gezeigten 
zeitlichen Positionen der 
der Signal Flanken 
bekommen Sie angezeigt, 
wenn Sie den Cursor über 
dem Delay D0 plazieren. 

 

 

  

Verzögerungen haben selten feste Zeiten – zur 
Einstellung hat auch ein Delay Properties. 

Mit DLM auf dem Delay öffnen Sie das Delay 
Properties Fenster und können hier bessere 
Namen und Min / Max – Zeiten eingeben. 

Weiter unten in Delay Properties  im Feld 
Display Label bestimmen Sie die Anzeige im 
Timing Diagramm: D0 oder etwas sinnvolleres. 

 

  

 

So sieht’s aus: Ein Delay von einer CLK0-Flanke zu einer 
SIG0-Flanke mit Min-/Max-Zeiten. 

Weiter unten in Delay Properties  im Feld Display as 
Curved Arrow bestimmen Sie die Anzeige der Delay 
Bemaßung. 

 
Dieses Dokument ist in Anlehnung an das Tutorial „Timing Diagram Editing and Analysis 2007“ entstanden. 
Im Help Menue und im help Ordner der installierten Software finden Sie weitere sehr hilfreiche Tutorials.  
Weitere Fragen beantworten wir Ihnen gern. 
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Bearbeitung und Analyse der Zeitdiagramme 
Dieses Tutorial demonstriert die grundliegenden Eigenschaften des Zeitdiagramm-Editors vom 
WaveFormer Pro, Timing Diagrammer Pro, VeriLogger Pro, DataSheet Pro und dem TestBencher 
Pro. Es wird gezeigt, wie die Zeitdiagramme gezeichnet werden und die Definition der Parameter für 
Verzögerungszeiten, Setup- und Hold-Zeiten, Taktfrequenzen und Bauteilbibliotheken erfolgt.  
Die Zeitdiagramme sollen anschließend dem Anwender beim Auffinden von kritischen Signalverläufen 
( Critical Races, Hazards,…) in digitalen Designs behilflich sein. Außerdem werden die Funktionen für 
das Bearbeiten der Signalformen, Messen der Zeitinformationen und die Programmoberfläche 
(Shortcuts, Buttons) behandelt. 

Sie werden das zeitliche Verhalten für die Schaltung Figure 1 zeichnen und analysieren. Der 
Schaltkreis halbiert die Taktrate. Das Flip-Flop und der Inverter haben Signallaufzeiten, welche die 
Ankunft des Signals Dinput verzögern. Sollte sich Dinput zu sehr verspäten, wird die Setup-Zeit (data-
to-clock) verletzt. Hierdurch steigt das Risiko, dass das Flip-Flop nicht während des Clocks den 
gewünschten (invertierten) Qoutput-Zustand am  Dateneingang (Dinput) vorfindet. Der Schaltkreis 
wird Metastabil.  

 

 

Bild 2 : Vollständiges Zeitdiagamm (Eingefügt per Copy-to-Clipboard)

Schaltungsparameter:   

clk 20MHz (50ns period) 

DFFtp 5-18ns D flip-flop (74ALS74): Clock to Q propagation time 

Dsetup 15ns minimum D flip-flop (74ALS74): D to rising edge Clock setup 
time 

INVtp 3-11ns Inverter (74ALS04): propagation time 

Das Bild 2 zeigt das vollständige Zeitdiagramm des Schaltkreises. Das erste was auffällt, 
sind die grau hinterlegten Signalwechsel, welche aus den min/max-Werten der Komponenten 
resultieren. Die grauen Felder stellen unbestimmte Zeitbereiche dar, in denen zu jedem 
beliebigen Zeitpunkt ein Signalwechsel möglich wäre. Dieses ist ein wenig ungewöhnlich, 
insbesondere wenn man Simulatoren verwendet, die nicht in der Lage sind min- und max-
Werte zur gleichen Zeit zu simulieren. Diese Art der Darstellung zeigt den gesamten Bereich 
der möglichen Arbeitsweise der Schaltung. Mit dem WaveFormer gibt es keine bösen 
Überraschungen bei der Produktion wenn Komponenten am äußersten Rand des 
Toleranzbereiches verwendet werden. 
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1) Einstellen der Zeitbasis (Base Time Unit) 
Am Anfang eines Projektes wird die Einheit der Zeitbasis gewählt. Die Einheit repräsentiert 
den kleinstmöglichen Zeitwert, die der WaveFormer abbilden kann. D.h. die Einheit der 
Zeitbasis definiert den Bereich des gesamten Zeitdiagramms.  Alle Zeitwerte werden intern in 
der “Base Time Unit” abgelegt. 

In der Schaltung Figure1 sind die Signallaufzeiten der Gatter in der Einheit Nanosekunden 
angegeben. Die Periodendauer des Taktsignals ist 20ns. Allgemein ist es sinnvoll, die 
Zeitbasis eine Einheit geringer als die Arbeitseinheit zu wählen. Man erhält so vernünftige 
Rundungsergebnisse bei mathematischen Operationen (Frequenzangaben werden invertiert 
und als Periodendauer verwendet). Deshalb wird in dem Beispiel als Zeitbasis Picosekunden 
gewählt.  

1. Selektieren des Menus Options > Base 
Time Unit . Es wird die Dialogbox Base Time 
Unit angezeigt, in dem per Selektion die 
Einheit der Zeitbasis definiert wird. Die 
weiteren Einstellungen kontrollieren, wie sich 
Änderungen der Zeitbasis auf existierende 
Parameter auswirken sollen. In der Online-
Hilfe sind weitere Informationen zu den 
einzelnen Optionen zu finden. 

2. Klick auf ps um Picosekunden als Zeitbasis 
zu definieren.  

3. Klick auf OK um die Änderung zu 
übernehmen. 

 

 

2) Einstellen der Anzeige (Display Time Unit) 
Als nächstes muss die Einheit für den Anzeigewert definiert werden. Die Einheit der 
Zeitanzeige bestimmt für alle Zeiten die eingegeben bzw. angezeigt werden, deren Einheit. 
Es sollte die Einheit gewählt werden, die im allgemeinen im Entwurf verwendet werden.  

1. Aktivieren des Menus Options > Display Unit. In einem Untermenu werden die 
verfügbaren Einheiten angezeigt. Die mit dem „Korrekt“-Marker versehende Einheit ist 
in Gebrauch (Default is ns = nanoseconds). 

 

2. Klick auf ns. 
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3) Anlegen einer Taktfrequenz (Clock) 
Zuerst soll der Takt erstellt werden. Der Name des Taktes ist clk, hat eine Periodendauer 
von 50ns (20MHz) und beginnt mit einem „Low“-Segment 

1. Führen Sie den Mauszeiger über den Add 
Clock Schalters   ( NOCH NICHT 
AKTIVIEREN) , links oben im 
Zeitdiagrammfenster. 

2. Beachten Sie, dass im Statusbalken links 
unten eine Meldung erscheint, welche die 
Funktion der Operation beschreibt 

. Die Meldungen im 
Statusbalken sind abhängig von der Position 
des Mauszeigers und in welchem Mode 
gearbeitet wird. Der Statusbalken ist 
besonders hilfreich, wenn man die Funktion 
von Druckknöpfen oder die Reihenfolge von 
Programmoperationen erklärt haben möchte.

3. Drücken Sie den Add Clock Schalter 
. 

4. Das Edit Clock Parameters Dialogfenster 
erscheint. 

5. Geben Sie den Namen clk ein. 

6. Geben Sie die Periode  50 ein. Vergewissern 
Sie sich, dass MHz/ns eingestellt ist. 
Beachten Sie, dass die Taktfrequenz sich 
entsprechend des neuen Periodenwertes 
ändert, sobald ein anderes Eingabefenster 
selektiert wird. 

7. Selektieren Sie invert.  Clocks beginnen 
normalerweise mit einem High-Zustand zum 
Zeitpunkt “Null”.  

8. Bestätigen Sie mit OK. 

 

Bemerkung: Weitere Informationen zu Clocks, Master Clocks, Clocks mit Formeln und 
Clockraster stehen im Kapitel 2 : Clocks in der Online-Hilfe. Sollte Ihnen bei der Definition 
des Clocks ein Fehler unterlaufen sein, lässt sich dieses nachträglich beheben. Einfach ein 
doppelten Mausklick auf ein Taktsegment, um das Fenster Edit  Clock Parameters erneut 
zu öffnen. Man kann auch einen doppelten Mausklick auf den Namen des Taktes 
durchführen um in das Signal Properties Dialogfenster und von dort mit Clock Properties 
in das entsprechende Fenster zu gelangen. 
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4) Das Hinzufügen von Signalen (Add Signals) 
Als nächstes sollen zwei Signal hinzugefügt werden. Nennen Sie die "Qoutput" und "Dinput". 

1. Doppelter Mausklick Links (2*LMB - Left Mouse Bottum) auf den Add Signal Schalter  
  um zwei neue Signale hinzuzufügen. Die Signale erhalten „Default“-Namen 

wie SIG0 und SIG1.  Aufgabe : Verändern Sie den Defaultwert! 

2. 2*LMB auf den Signalnamen SIG0 um das Signal Properties Dialogfenster zu öffnen. 

3. Tragen Sie das Eingabefeld „Name“ Qoutput ein. (NICHT DAS FENSTER 
SCHLIEßEN!) 

 

4. Durch betätigen des Schalters  oder der Hotkey  ALT-N gelangt man zum 
nächsten Signal im Zeitdiagramm. SIG1 wird jetzt im Eingabefeld “Name” angezeigt. 

5. Tragen Sie Dinput in das Eingabefeld “Name” und bestätigen Sie mit OK, um das 
Dialogfenster zu schließen 

Sollte das Dialogfenster Signal Properties versehentlich geschlossen wurden sein, genügt 
ein erneuter Mausklick (2*LMB) um das Fenster zu öffnen. Die Funktionen der boolschen 
Ausdrücke bzw.  Simulation werden später beschrieben. Die Signal Properties sind 
unabhängig von dem gerade verwendeten Arbeitsmodus, d.h. das Fenster kann durchaus 
geöffnet bleiben, während im Zeitdiagramm editiert wird. 

 

5) Das Zeichnen von Signalformen 
Als nächstes sollen wahllos Signalverläufe gezeichnet werden, um sich an die 
Funktionsweise des Werkzeuges zu gewöhnen. 

1. Beachten Sie die Schalter mit den Signalsymbolen . 
Es handelt sich um die jeweiligen Signalzustände. Der aktive Schalter ist rot und 
beschreibt den Signaltyp der als nächstes gezeichnet wird. In diesem Fall ist das 

HIGH Signal  aktiv. 

2. Bewegen Sie den Mauszeiger in das Zeitdiagramm (auf Höhe des Signalnamens 
Qoutput) bei ca.  40ns. 
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3. LMB (Left Mouse Bottum) um ein Signalsegment von 0 ns bis zum Mauszeiger zu 
Zeichnen. Beachten Sie, dass ein HIGH-Signal angelegt wurde. 

4. Ein anderer Signalschalter ist jetzt aktiv. Die Schalter „springen“ automatisch zwischen 
den beiden zuletzt verwendeten Zuständen hin und her. Das kleine rote T  (Toggle) 

verweist auf den nächsten Zustand, z.B. . (Bei einer 3 Tastenmaus kann mit dem 
mittleren Mausknopf zwischen den beiden zuletzt aktivierten Signalen “getoggelt” 
werden) 

5. Platzieren Sie den Mauszeiger bei etwa 80 ns im gleichen Signal und betätigen Sie  
den LMB. Jetzt sollte ein LOW Segment vom Ende des HIGH Signals zu der jetzigen 
Position gezeichnet wurden sein. 

6. LMB auf den TRI Schalter  um den Tristate Mode zu aktivieren und ein 
entsprechendes Signal zu Zeichen. 

7. Zeichnen Sie verschieden Segmente in allen beliebigen Zuständen, ausschließlich 
dem HEX Schalter. Der HEX Schalter wird zur Definition von Multi-Bit Signalen bzw. 
Benutzerdefinierten VHDL-Typen benutzt. Dazu später noch mehr. Jetzt sollen vorerst 
die grafischen Zustände ausreichen.. 

Das Zeitdiagramm sollte jetzt sehr einfach erstellt werden und zuletzt wie in Bild 2 
ausschauen (ohne Delays un Setups). 

 

6) Das Bearbeiten von Signalfolgen 
Es gibt 4 Grundtechniken um existierende Signale zu modifizieren ( Achtung! Diese 
Techniken funktionieren nicht bei Clocks). Die am häufigsten verwendete Technik, ist das 
Verschieben von Signalflanken zu einer neuen Position. Die anderen 3 Techniken beziehen 
sich jeweils auf das Segment zwischen zwei Signalflanken. Segmente lassen sich löschen, 
modifizieren usw. Probiere jede der folgenden: 

1. Verschieben Sie eine Flanke: LMB (gedrückt halten) und verschieben zur 
gewünschten Position. Ein grüner Strich erscheint und folgt den Zeigerbewegungen 

. LMB loslassen an der gewünschten Position. 

2. Modifizieren des Signalzustands: LMB auf das Segment (das selektierte Segment 

wird mit einer grünen Umrandung dargestellt ). Anschließend den 
gewünschten Schalter mit dem Signalzustand betätigen. 



E
D

V 
 B

E
R

AT
U

N
G

S
-  

 U
N

D
H

AN
D

EL
S

G
E

SE
LL

SC
H

A
FT

W
ED

E
L E

R
 L

AN
D

S
TR

. 9
3

22
55

9  
HA

M
BU

R
G

TE
l. :

 (0
4 0

) 1
89

8 0
52

0
F A

X
: (

04
0 )

 8
11

03
7

H
ttp

: //
w

w
w.

da
ta

b i
t .d

e

 

@ copyright für dies Ausführung liegt bei Karl-Heinz Stryi. Diese Anleitung darf nur für das Selbststudium 
verwendet werden. Eine kommerzielle Nutzung oder Handel hiermit ist untersagt. 

3. Löschen eines Segments: Segment selektieren (siehe oben) und dann die 
Entfernen-Taste betätigen 

4. Einfügen eines Segments: Innerhalb eines größeren Segments LMB (gedrückt 
halten) und nach rechts verschieben. Dann Mausknopf loslassen. Ein neues Segment 
wird eingefügt. 

Die Techniken arbeiten nicht bei Clocks, da ein Takt vordefinierte Segmente und 
Signalflanke besitzt. Um die Taktfrequenz zu modifizieren, genügt ein 2*LMB auf ein 
Clocksegment im Zeitdiagramm. In dem erscheinenden Dialogfenster Edit Clock Parameters 
lassen sich alle Eigenschaften des Taktes editieren. 

Mehr Informationen in der Online-Hilfe Kapitel 4 “Drawing WaveForms” 

 

7) Einstellen des Zeitdiagramms  
Jetzt sollen die bisher beschriebenen Techniken dazu verwendet werden, dass alle Signale 
so ähnlich wie in dem unten abgebildeten Timing dargestellt werden. Das ist zwar nicht der 
übliche Weg Zeitdiagramme anzulegen, übt aber die Editierfunktionen des WaveFormers. 
Probieren Sie jede der beschriebenen Techniken. 

 

Legen das Zeitdiagramm und die Parametertabelle nebeneinander um deren Synchronität zu 
beobachten. Das Report-Fenster wird in dieser Übung nicht benötigt. Schalten Sie es 
deswegen aus, um möglichst viel Bildschirmfläche für den Rest zu haben. 

• Selektieren Sie eine der Optionen Window > Tile..... 

Richten Sie die Ansicht so ein, dass nur 3 Taktzyklen auf dem Bildschirm gezeigt werden.  

• LMB auf die Schalter Zoom In oder Zoom Out , die rechts oben über dem 
Zeitdiagramm zu finden sind, um mehr bzw. weniger von den Signalen zu Zeigen.  

• Selektion eines Segments bzw. Flanke und anschließend Zoom In/Zoom Out  

• LMB (gedrückt halten) und bis zu der gewünschten Position mit dem Mauszeiger nach 
rechts verfahren. Dort LMB loslassen. Der Start- und Endpunkt der Zeitachse definiert 
ein Zeitfenster, welches vergrößert dargestellt wird. 

• RMB /Right Mouse Buttom) in die Zeitleiste entspricht dem Befehl Zoom Out. 
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8) Der rechte Mausknopf (Modus): 
Jetzt sollen Verzögerungszeiten, Setup- und Hold-Zeiten oder einfach nur Textkommentare 
platziert werden. Diese Objekte sind per RMB einzufügen. Die Schalter DELAY, HOLD, 

SETUP, TEXT, SAMPLE und MARKER  definieren den Arbeitsmodus. Der rote 
Schalter kennzeichnet den jeweiligen aktiven Arbeitsmodus, welcher mit einem LMB 
umgeschaltet wird. 

 

9) Hinzufügen der Verzögerungszeit des D-Flip-Flops 
Definieren Sie die Verzögerungszeit zwischen positiver Taktflanke und Qoutput des D flip-
flop. Gehe folgendermaßen vor: 

1. Aktivieren Sie ggf. den Delay-Modus . 

2. LMB auf die erste ansteigende Flanke des Clocks. 

3. RMB auf die erste fallende Flanke des Signals Qoutput . 

Es wird die Signallaufzeit des D-flip-flop angezeigt und im Parameterfenster ein “leerer” 
Parameter D0 angelegt. 

 

  

 

Wenn Delays angelegt werden, sind diese Anfangs immer undefiniert und haben keine 
Auswirkung auf das zeitliche Verhalten. Delays die keine zeitlichen Informationen besitzen, 
werden in grauer Farbe angezeigt. Jetzt editieren Sie die Parameter von D0: 

1. 2*LMB auf den Parametername D0 im Parameterfenster. Richten Sie sich das 
Dialogfenster Parameter Properties so ein, dass die Informationen in der 
Parametertabelle und im Zeitdiagramm zu sehen sind. Zur Vereinfachung wird zu den 
Dialogfenstern  Delay Properties und Signal Properties ab sofort Parameter Properties 
gesagt 

2. Geben Sie den Wert 5 in das Eingabefeld “min” und drücken TAB , um in das max-
Feld zu gelangen (max soll vorerst noch undefiniert bleiben).  

Zwei Sachen passieren durch die TAB-Taste: 

1. Zuerst verschiebt sich die fallende Flanke von Qoutput so, dass sie 5ns von der 
Taktflanke entfernt ist. Kontrollieren Sie dieses mit den beiden Zeitanzeigen über den 



E
D

V 
 B

E
R

AT
U

N
G

S
-  

 U
N

D
H

AN
D

EL
S

G
E

SE
LL

SC
H

A
FT

W
ED

E
L E

R
 L

AN
D

S
TR

. 9
3

22
55

9  
HA

M
BU

R
G

TE
l. :

 (0
4 0

) 1
89

8 0
52

0
F A

X
: (

04
0 )

 8
11

03
7

H
ttp

: //
w

w
w.

da
ta

b i
t .d

e

 

@ copyright für dies Ausführung liegt bei Karl-Heinz Stryi. Diese Anleitung darf nur für das Selbststudium 
verwendet werden. Eine kommerzielle Nutzung oder Handel hiermit ist untersagt. 

Fenster der Signalnamensignal. LMB auf die erste Flanke. Verschieben Sie die Maus 
zu der zweiten Flanke. Beachten Sie, dass ca. 5ns in der blauen Zeitanzeige zu lesen 
sind. Es wird die Differenz angezeigt!  Eine weitere Möglichkeit gibt es im Parameter 
Properties Dialogfenster. Es lässt sich unter Display label auch die Differenz 
(distance) der Flanken anzeigen. 

2. Zum Zweiten verändert sich die Farbe der Delay von Grau in Blau. Delays sind 
farbkodiert, um anzuzeigen welche Delays den min bzw. max Wert einer Flanke 
verursacht. Die Anzeige der kritischen „Pfade“ ist notwendig, wenn mehrere Delays 
mit der gleichen Flanke verbunden sind (Rekonvergente Fanouts). Die Farben sind 
Grau = keine, Blau = Min, Grün = Max, Black = Min und Max. Später empfiehlt es sich 
mit der Datei multdely.tim zu experimentieren, um die Auswirkungen von 
rekonvergenten Fanouts zu analysieren. 

Geben Sie den Rest der Parameter ein. Der Parametername ist "DFFtp", mit 18nx max Wert, 
der Beschreibung "Clk to Q propagation time".  

1. LMB in das Feld “Name” und DFFtp 
eingeben. 

2. Betätigen Sie zweimal die TAB-
Taste, damit das max-Feld aktiv ist. 

3. Geben Sie 18 ein. (Entspricht 18 
display time units => 18ns) 

4. TAB, um in das Kommentarfeld zu 
gelangen. 

5. Geben Sie Ck to Q propagation 
time ein 

  

 

Beachten Sie, dass DFFtp in Schwarzer Farbe dargestellt wird, d.h. die früheste bzw. 
späteste Flanke des Signals Qoutput ist ausschließlich abhängig von dem Clock. Weiterhin 
zeigt die fallende Flanke von Qoutput einen unbestimmten Zeitbereich, der Grau dargestellt 
ist. 

Messen Sie die Differenz des Zeitbereichs (18-5=13ns) einmal mit Hilfe der Zeitanzeigen und 
zum anderen per 2*LMB auf die Flanke (zeigt die exakten Werte an). 

Das Dialogfenster Parameter Properties ist modeless (d.h. es kann geöffnet bleiben 
während man andere Operationen durchführt) und interactive (alle Änderungen werden 
übernommen, sobald das Eingabefeld verlassen wird). In den Übungen wurde das Fenster 
häufig geschlossen und wieder geöffnet, so das der Anwender verschiedene Wege kennen 
lernen konnte. Wahrscheinlich bevorzugt man beim täglichen Gebrauch ein Arbeiten mit 
offenem Parameterfenster.  

Tip: Wenn das Fenster Parameter Properties geöffnet ist, lassen sich die verschiedenen 
Parameter mit einem Doppelklick im Zeitdiagramm bzw. Parametertabelle einfach 
editieren. Mit einem Doppelklick im Zeitdiagramm wird der bestimmte Parameter bearbeitet 
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( die Change All Instances check box ist NICHT selektiert). Wenn dagegen ein Parameter 
per Doppelklick in der Parametertabelle aktiviert wird, sind alle gleichnamigen Parameter 
betroffen (die Change All Instances check box ist selektiert). 

10) Hinzufügen der Verzögerungszeit des Inverters 
Als nächstes soll die Signallaufzeit des Inverters zwischen dem Eingang Q und dem 
Ausgang D.  

1. Aktivieren Sie den DELAY mode (LMB). 

2. LMB auf dei erste fallende Flanke des Signals Qoutput (Die Flanke, auf der "DFFtp" 
endet). 

3. RMB auf die erste ansteigende Flanke des Dinput Signal. 

Hierdurch wird die Verzögerung des Inverters angelegt und ein leeres Feld erscheint im 
Parameterfenster. Jetzt soll der Parameter im Zeitdiagramm editiert werden, anstatt in das 
Parameterfenster zu gehen. 

1. LMB auf die neue “delay” im Zeitdiagramm und die folgende Werte in die 
erscheinende Dialogbox eintragen: 

o Name ist INVtp. 

o Min time ist 3 ns. 

o Max time ist 11 ns. 

o Comment ist Inverter (Q to D) delay. 

o Click auf OK, um das Fenster zu schließen. 

 

 

Beachten Sie den unbestimmten Zeitbereich von Dinput . LMB auf die erste ansteigende 
Flanke von Dinput, dann benutzen Sie die blaue Zeitanzeige um zu prüfen, dass der 
unbestimmte Zeitbereich bei 21 ns endet (13ns von DFFtp + 8ns von INVtp = 21ns).  

Danach klicken Sie auf die erste Flanke von clk und messen den Abstand zum Ende des 
unbestimmten Zeitbereichs von. Wenn der Inverter und das D flip-flop langsam sind, wird 
Dinput möglicherweise nicht vor 29ns nach der Taktflanke schalten. 
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11) Hinzufügen von Setup zu dem Dinput Signal 
Fügen Sie die Zeit für das “setup” von Dinput zum Takt ein. 

1. Aktivieren Sie den Setup mode . 

2. LMB auf die erste ansteigende Flanke des Signals Dinput signal (dort wo die "INVtp" 
delay endet). 

3. RMB auf die zweite ansteigende Flanke des Taktes clk. 

 

Es erscheint ein Setup Parameter. Beachte das die Pfeile des Setup-Parameters zum 
kontrollierenden Signal zeigen. Das bedeutet, dass das Setup korrekt platziert wurde. 

Genau wie bei Verzögerungszeiten, werden Setups mit leeren min/max Werten angelegt. Es 
muß ein min-Wert eingetragen werden, bevor die Signalposition beobachtet werden kann. 

1. 2*LMB auf den Namen des Setups 
im Zeitdiagramm. Das Parameters 
Properties Fenster erscheint. 

2. Tragen Sie den Namen Dsetup ein. 

3. Tragen Sie 15 in das min-
Eingabefenster. 

4. Tragen Sie Check for metastable 
condition in das Kommentarfeld. 

5. OK, um das Dialogfenster zu 
schließen. 

  

 

Beachte Sie, dass die Spalte “margin” in der Parametertabelle einen Wert von 6ns anzeigt, 
bevor die Setup-Zeit verletzt wird. Überprüfen Sie den Wert, indem Sie zuerst die zweite 
ansteigende Flanke des Clocks und dann das Ende des unbestimmten Zeitbereichs von 
Dinput selektieren. Die blaue Zeitanzeige (Delta-Marker) sollte -21ns anzeigen (setup 15ns - 
gemessene 21ns = -6ns margin). 

Als nächstes soll eine Verletzung der Setup-Zeit ausprobiert werden. Vergrößern Sie die 
Verzögerungszeit des Inverters auf 18ns anstatt 11ns. 
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1. 2*LMB auf INVtp im Zeitdiagramm. 

2. Tragen Sie den Wert  18 in das max Eingabefeld und gehe mit TAB in ein anderes 
Feld. 

 

Die Setup-Zeit wird jetzt im Zeitdiagramm und Parametertabelle in roter Farbe dargestellt. 
Ändern Sie die Verzögerungszeit des Inverters zurück auf 11ns un bestätige mit OK. 

12) Hinzufügen einer Variablen ( Free parameter) 
Bisher wurde alle Parameter direct bearbeitet bzw. Eingegeben. Das ist jedoch in der Regel 
nicht gerade sehr effizient und bei größeren Schaltungen dazu fehlerträchtig. Es ist besser 
eine Variable zu definieren, welche einen bestimmten Wert symbolisiert. Wenn der Wert 
geändert werden sollte, genügt die Bearbeitung nur einer Variablen. 

„Free Parameter” sind solche Variable, die in anderen Parametern referenziert werden 
können. Die Parameter werden als  "free" bezeichnet, weil sie keinem Signalwechsel im 
Zeitdiagramm direkt zugeordnet sind. Legen Sie einen Free Parameter für den Inverter an: 

Hinzufügen eines Free Parameter: 

1. LMB auf Add Free Parameter   in der ParameterTabelle. Ein Free 
Parameter erscheint (mit leerem Eingabefeld). 

2. 2*LMB auf die Variable zum Öffnen der Dialogbox Parameter Properties. Tragen Sie 
die folgenden Informationen ein (tpFreeInv, 3ns, 11ns und 74ALS04 inverter delay) 
für (name, min, max und comment cells) des freien Parameters. 

 

3. Verwenden Sie die Schalter Previous und Next ii der Dialogbox Parameter 
Properties, um den Parameter INVtp zu finden. 
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4. Tragen Sie tpFreeInv in die min und max Felder von INVtp ein. Änderungen in der  
Variablen betreffen jetzt auch INVtp. 

Achtung: Free Parameter lassen sich in speziellen Bibliotheken abspeichern, welche dann 
in anderen Projekten wieder eingebunden werden können. Man kann sogar auf Variable 
referenzieren, ohne diese in ein bestehendes Projekt zu laden. Hierzu sind die 
Bibliotheken nur im Suchpfad „library search path” (Libraries > Library Preferences menu 
option) einzutragen. 

 

13) Die Verwendung von Formeln und Konstanten 
Parameter können mathematische Formeln enthalten, genauso wie nummerische Zeitwerte. 
Legale Operationen sind: Multiplikation(*), Division(/), Addition(+) und Subtraktion(-). Z.B., 
der Inverter in diesem Schaltkreis könnte 3 hintereinander geschaltete Inverter 
repräsentieren, um eine minimale Verzögerung von 9ns darzustellen.  

1. Tragen Sie den folgenden Ausdruck in das min Eingabefeld von INVtp: 

  3 * tpFreeInv 

• Freie Parameter können außerdem mit einem Attribut versehen werden 
(tpFreeInv.min und tpFreeInv.max). Dieses ermöglicht die Formeln individuell 
gestalten zu können. Wenn kein min bzw. max Attribut vergeben wurde, berücksichtigt 
das Programm den Wert in dem der Eintrag vorgenommen wurde.  

   


